Contents
1. Quick start Guide .................................................................................................................................. 3
2. Dependences ........................................................................................................................................ 4
3. Accessories ............................................................................................................................................ 4
4. Installation ........................................................................................................................................... 5
5. Introduction .......................................................................................................................................... 8
6. Main Menu .......................................................................................................................................... 10
7. Icons .................................................................................................................................................... 11
8. Tabs ..................................................................................................................................................... 11
9. Options (program settings) .................................................................................................................. 12
  • General tab .................................................................................................................................... 12
  • View tab .......................................................................................................................................... 13
  • Languages tab .................................................................................................................................. 14
10. Program ............................................................................................................................................ 15
  • Program Functions .......................................................................................................................... 17
11. Lock program settings ....................................................................................................................... 19
12. Template (Save / Load) .................................................................................................................... 19
13. Password protection .......................................................................................................................... 20
14. User defined settings .......................................................................................................................... 21
15. Download ........................................................................................................................................ 22
16. Graph .............................................................................................................................................. 23
  • Mouse Zoom: .................................................................................................................................. 24
  • Mouse Tool Tip: ............................................................................................................................... 24
17. Save/ save as ................................................................................................................................... 24
18. Auto-open PDF ................................................................................................................................ 25
19. Histogram ........................................................................................................................................ 25
20. Table ................................................................................................................................................ 26
21. Summary ......................................................................................................................................... 27
22. Bookmark ....................................................................................................................................... 28
23. MKT ................................................................................................................................................. 29
24. Multilink .......................................................................................................................................... 29
25. Battery Status .................................................................................................................................. 34
26. Print / Print-preview ........................................................................................................................... 34
27. Update ............................................................................................................................................. 34
Console Plus is new revolutionary software for new product line iMINI, iMINI USB PDF, xTag and all future releases of Escort Verification Technologies/Cryopak Verification Technologies (EVT/CVT) products. It has all features to program, download, view and analyze critical data.

1. Quick start Guide

ConsolePlus software currently supports following product range

<table>
<thead>
<tr>
<th>Product Family</th>
<th>Product code</th>
<th>Type</th>
<th>Total No. of Sensors</th>
<th>Sensor Location</th>
<th>Sensor Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>iMINI (yellow case)</td>
<td>MX-IN-S-8-L</td>
<td>Multi-use</td>
<td>1</td>
<td>Internal</td>
<td>NTC</td>
</tr>
<tr>
<td>iMINI (yellow case)</td>
<td>MX-ST-S-8-L</td>
<td>Single Use</td>
<td>1</td>
<td>Internal</td>
<td>NTC</td>
</tr>
<tr>
<td>iMINI (yellow case)</td>
<td>MX-OE-S-8-L</td>
<td>Multi-use</td>
<td>1</td>
<td>External</td>
<td>NTC</td>
</tr>
<tr>
<td>iMINI (yellow case)</td>
<td>MX-1E-S-8-L</td>
<td>Multi-use</td>
<td>2</td>
<td>One Internal &amp; One External</td>
<td>NTC</td>
</tr>
<tr>
<td>iMINI (yellow case)</td>
<td>MX-2E-S-8-L</td>
<td>Multi-use</td>
<td>2</td>
<td>Both External</td>
<td>NTC</td>
</tr>
<tr>
<td>iMINI (yellow case)</td>
<td>MX-HS-S-8-L</td>
<td>Multi-use</td>
<td>2</td>
<td>Both Internal</td>
<td>Digital sensor</td>
</tr>
<tr>
<td>iMINI (yellow case)</td>
<td>MX-HE-S-8-L</td>
<td>Multi-use</td>
<td>3</td>
<td>Two Internal &amp; One External</td>
<td>Digital sensor &amp; NTC</td>
</tr>
<tr>
<td>iMINI USB pdf (Plug &amp; Play)</td>
<td>MS-ST-S-8</td>
<td>Single Use</td>
<td>1</td>
<td>Internal</td>
<td>NTC</td>
</tr>
</tbody>
</table>

All new products from EVT/CVT will be supported by ConsolePlus. Software has in-built auto update feature, when a new release is available it will prompt user to upgrade to newest version. And with one click it will be updated.
2. Dependences

ConsolePlus can be installed on following platforms

- Windows XP
- Windows 7
- Windows 8

Adobe reader (latest Version) must be installed on the computer. If not, user may encounter error

- in PDF generation
- Print
- Print preview
- Software crash

3. Accessories

- For all iMINI (yellow case) data loggers **Type A to Mini-B USB cable** is required to connect data logger to the workstation

- iMINIUSB pdf data logger is Plug and Play data logger
4. Installation

Setup file can be downloaded from www.escortdataloggers.com for free

File name: ConsolePlusSetup.exe / ConsolePlusSetup.zip

I. When you get started you should try to install the following application file:

II. Once you have double clicked ConsolePlusSetup.exe file you will get the following Step through Wizard:

III. Browse to select the location of installation, if it is necessary or leave as default
Click NEXT

Click NEXT
Click INSTALL to install the necessary drivers

Click INSTALL
Click FINISH to complete the installation process

5. Introduction

ConsolePlus icon is created and placed on desktop after the installation is completed.

Launch ConsolePlus

a. **ConsolePlus** *.** on top Left Corner, *.** denotes current version number
b. When the application is launched for first time, the application window will open OPTIONS window and highlight in red text
c. A default directory for the data can be assigned here, once default directory is assigned, path becomes black
d. Home page is displayed and most of the tabs and functions are greyed out. User can do initial settings at this stage or whenever required by selecting options.

e. Make sure to manually check for *updates* before proceeding to next step.

Refer to Step 27
6. Main Menu

Most of the functions are disabled initially, and will be highlighted or available depending on if the data logger is plugged in or a file is open.
User can select ‘options’ any time and change the fields

- Open a previously saved file (target default directory)
- Save downloaded data of a logger
- Save downloaded data of a logger in different format e.g. csv & txt
- If multiple files are open and want to remove selected files from the list
- If multiple files are open and want to remove from list
- Select to open Options window
- Open a previously saved template, to program logger
- Save a new template, based on new program settings
- Create PDF from the open file, save in default directory
- Print preview
- Print
- Manually check for available software updates
7. Icons

8. Tabs

Home: It display homepage
Program: Program settings of a programmed logger, or to program a logger
Graph: Graph view of downloaded data a logger or a file
Histogram: Histogram view of downloaded data a logger or a file
Table: data/readings of all sensors of downloaded data of a logger or a file
Summary: Summary view of downloaded data of a logger or a file
9. Options (program settings)

- **General tab**
  
a. Click options, either from MENU, File – Options or simply by clicking icon

b. By default opens **General** tab,

![Options window]

  - **Show Help Window**: Displays Help window on right hand side of application if checked
  - **Auto Download Logger**: If checked - auto download data from a logger as soon as logger is connected
  - **Auto Save Logger**: If checked - downloaded data from a logger is auto-saved in default directory
  - **Auto Generate TXT**: If checked - data from a logger is auto-saved as txt file in default directory
  - **Auto Generate CSV**: If checked - data from a logger is auto-saved as CSV file in default directory
  - **Auto Generate PDF**: If checked - data from a logger is auto-saved as PDF file in default directory
  - **Auto open PDF**: If checked - saved PDF file will auto-open (adobe acrobat must be installed)

  - **Unit Display**: Can be selected Celsius or Fahrenheit
  - **Compare trip data based on actual date/time of each reading**: When data is multi-linked (actual time)
  - **Compare trip data from different date/time period(s)**: When data is multi-linked (from 1st reading)
  - **MKT Activation Energy (kJ/mol)**: User can customize ‘Activation Energy’ value, to calculate MKT

  - **Default Path**: C:\Test_results

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]

  ![Options dialog box]
• **View tab**

In View Tab, Graph and Histogram color settings can be changed and set as required.
• **Languages tab**

Six languages available to select from the list
10. Program

a. Plugin USB mini port to iMINI and connect the USB port into an available USB slot on workstation. (USB 5pin Mini cable to USB)

b. **ConsolePlus** application will recognize the iMINI and will be available on left hand Logger / File List pane

c. **ConsolePlus** application will display the serial number of iMINI and the alarm status. In functions tab it will reach to GRAPH tab by default.

<table>
<thead>
<tr>
<th>Connected logger</th>
<th>Communication port number, Serial number and Alarm status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open File</td>
<td>File location, Serial number and Alarm status</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#</th>
<th>Device</th>
<th>Name</th>
<th>Desc.</th>
<th>LL</th>
<th>L</th>
<th>OK</th>
<th>H</th>
<th>HH</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>COM65</td>
<td>MX-CD-120-4102</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>C:\Test.ref</td>
<td>MX-CD-116-003</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Text</th>
<th>Description</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>LL</td>
<td>If Low Low Alarm has triggered</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>If Low Alarm has triggered</td>
<td></td>
</tr>
<tr>
<td>OK</td>
<td>If no alarm has triggered</td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>If High Alarm has triggered</td>
<td></td>
</tr>
<tr>
<td>HH</td>
<td>If High High Alarm has triggered</td>
<td></td>
</tr>
</tbody>
</table>

d. If the function tabs are greyed out, click ‘download’ icon from the top

e. Select PROGRAM tab. All the previous program information of connected logger is displayed.

f. If logger has only one sensor or other sensor combination, the respected tabs are greyed out by default. Software auto-detects the type of logger and display existing information

**Logger with external sensor only (MX-OE-S-8-L) will appear on 1st tab and title will appear int/ext temp. (NTC) Instead of Int. Temp (NTC)**
PROGRAM TAB

1. [Description] Escort Verification Tech.
   - **Int. Temp (NTC)**: 32.0 [Enable] [Enable Sensor]
   - **High°C**: 30.0 [Enable] [Consecutive delay before Alarm: 1]
   - **Low°C**: 22.0 [Enable] [Total delay before alarm: 1]
   - **LLow°C**: 20.0 [Enable]

2. [Description] Int. Hum
   - **High%**: 80.0 [Enable] [Consecutive delay before Alarm: 1]
   - **Low%**: 40.0 [Enable] [Total delay before alarm: 1]
   - **LLow%**: 20.0 [Enable]

3. [Description] Ext. Temp (NTC)
   - **High°C**: 12.0 [Enable] [Total delay before alarm: 1]
   - **Low°C**: 8.0 [Enable] [Consecutive delay before Alarm: 2]
   - **LLow°C**: 2.0 [Enable] [Total delay before alarm: 2]

4. [Description] Ext. Temp (Digital)
   - **High°C**: 12.0 [Enable] [Total delay before alarm: 1]
   - **Low°C**: 8.0 [Enable] [Consecutive delay before Alarm: 2]
   - **LLow°C**: 2.0 [Enable] [Total delay before alarm: 2]
### Program Functions

<table>
<thead>
<tr>
<th>No.</th>
<th>Details</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Firmware version of connected logger, or the logger of saved file</td>
<td>Read / write</td>
</tr>
<tr>
<td>2</td>
<td>Enter Password, up to 8 numbers</td>
<td>Read only</td>
</tr>
<tr>
<td>3</td>
<td>Allow to read the logger without password</td>
<td>Write only</td>
</tr>
<tr>
<td>4</td>
<td>Allow to program the logger without password</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Serial number of the logger</td>
<td>Read only</td>
</tr>
<tr>
<td>6</td>
<td>Product code of the logger</td>
<td>Read only</td>
</tr>
<tr>
<td>7</td>
<td>Memory size of the logger</td>
<td>Read only</td>
</tr>
<tr>
<td>8</td>
<td>Trip number of the logger</td>
<td>Read only</td>
</tr>
<tr>
<td>9</td>
<td>Temperature range of the logger</td>
<td>Read only</td>
</tr>
<tr>
<td>10</td>
<td>Description</td>
<td>Read / Write</td>
</tr>
<tr>
<td>11</td>
<td>Sensor Int temp. / ext temp / Humidity</td>
<td>Read / write</td>
</tr>
<tr>
<td>12</td>
<td>High High Alarm threshold</td>
<td>Read / Write</td>
</tr>
<tr>
<td>13</td>
<td>High Alarm threshold</td>
<td>Read / Write</td>
</tr>
<tr>
<td>14</td>
<td>Low Alarm threshold</td>
<td>Read / Write</td>
</tr>
<tr>
<td>15</td>
<td>Low Low Alarm threshold</td>
<td>Read / Write</td>
</tr>
<tr>
<td>16</td>
<td>Sensor enable / disable</td>
<td>Read / Write</td>
</tr>
<tr>
<td>17</td>
<td>Consecutive delay before alarm (1 – 254)</td>
<td>Read / Write</td>
</tr>
</tbody>
</table>

---

![Diagram of Console Plus User Manual version 3.1](image-url)
<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>18</td>
<td>Total delay before alarm (1 – 254)</td>
<td>Read / Write</td>
</tr>
<tr>
<td>19</td>
<td>Interval between each reading (5 seconds to 17H:59M:59S)</td>
<td>Read / Write</td>
</tr>
<tr>
<td>20</td>
<td>Start the logger at pre-defined date and time</td>
<td>Read / Write</td>
</tr>
<tr>
<td>21</td>
<td>Select the start delay</td>
<td>Read / Write</td>
</tr>
<tr>
<td>22</td>
<td>Show Alarms on the display</td>
<td>Read / Write</td>
</tr>
<tr>
<td>23</td>
<td>Show temperature on the display</td>
<td>Read / Write</td>
</tr>
<tr>
<td>24</td>
<td>Enable alarms, select / deselect, any or all</td>
<td>Read / Write</td>
</tr>
<tr>
<td>25</td>
<td>Duration of the trip, can be user defined, or choose from list</td>
<td>Read / Write</td>
</tr>
<tr>
<td>26</td>
<td>Memory used in previous trip</td>
<td>Read only</td>
</tr>
<tr>
<td>27</td>
<td>Stop the logger at pre-defined time (if selected)</td>
<td>Read / Write</td>
</tr>
<tr>
<td>28</td>
<td>Stop the logger after &quot; &quot; number of readings have been taken</td>
<td>Read / Write</td>
</tr>
<tr>
<td>29</td>
<td>Enable stop button</td>
<td>Read / Write</td>
</tr>
<tr>
<td>30</td>
<td>Battery status Icon</td>
<td>Read only</td>
</tr>
<tr>
<td>31</td>
<td>Enable non-stop logging (not available for single use loggers)</td>
<td>Read / Write(multi use)</td>
</tr>
<tr>
<td>32</td>
<td>Auto-reset enabled (not available for single use loggers)</td>
<td>Read / Write(multi use)</td>
</tr>
<tr>
<td>33</td>
<td>Total time for the designated trip</td>
<td>Read only</td>
</tr>
</tbody>
</table>

**NOTE:** Logger can be started by TIME / START button (immediate start or with delay) or with both options enabled. Please select these settings carefully and hit PROGRAM icon.

And hit PROGRAM icon.

g. A confirmation dialogue will appear for the final approval.

![Question?
This will program the Logger](image)

h. After acceptance bottom left corner progress bar will progress and display 100%.

![Progress bar](image)

i. ‘READY’ will be on the LCD display of iMINI

Logger is ready to start logging, according to settings (timer or button) logger will start measuring and recording the data.
11. Lock program settings

Adjust the necessary fields or program settings for the next trip, (user can lock these settings if more loggers need to be programmed automatically (when connected). By clicking icon , it will turn as : the locked fields will : highlighted in PROGRAM tab in RED font as shown
This function is only available for the same product; product code must be similar for the next logger to be auto-programmed

12. Template (Save / Load)

Program settings of a Data Logger can be saved as template and be used for future.

Save Template Program: User can save template from a data file (CVT) or from a connected logger. File will be with extension *.xtp and saved at default location

Load Template Program: User can use previously save template (extension *.xtp). If loaded, program will fill all the settings in the fields and will be displayed in Red color fonts (as above). Program lock icon will be locked and program icon will be highlighted as soon as the logger is plugged in and can be programmed with these saved settings
13. Password protection

In password protection, from one to eight numbers can be assigned during program, no alphabets are accepted.

- Initially entire field is blank and Allow RD / Allow WR are greyed out

- Allow RD / Allow WR will be available to select as soon as number is entered Pass R/W filed
  If none of the options, Allow RD / Allow WR is selected, user has to enter password to Program / Download data

- If Allow RD is selected during program, user can Download the data without password, but not be able to Program

- If Allow WR is selected during program, user can Program the logger without password, but not be able to Download the data

When logger is connected next time, ConsolePlus ask for a password depending on the option selected, if Allow RD is selected during program, Read Without Password – READ button will be highlighted and clickable. After the click ‘Download’ button will be enabled and data can be downloaded manually by click or if Auto Download’ is enabled if Allow WR is selected during program, Write Without Password – WRITE button will be highlighted and clickable. After the click ‘Program’ tab will be enabled
14. User defined settings

User can program the logger by selecting the list of pre-set no. of days from drop down list

Settings of 1 day to 60 day are available. Program will use full memory of the logger and set the time interval between each reading accordingly
15. Download

a. Plug iMINI into the USB mini port and run the USB port into an available USB slot on workstation.

b. ConsolePlus will auto download (if checked in options)

c. Or user can always force the software to download by clicking icon

d. A progress bar will appear (left bottom corner)

e. Currently captured data or data of previous trip (if logger is displaying STOPPED) will be downloaded and will render the graph immediately of the data

f. Download is also possible even if there is no data in the logger or new mission / trip has not started and device is displaying READY. In some events previous trip data is available.

This helps if logger is accidently programmed and hasn’t yet started, user has a chance to recover the data

g. Download option will be disabled if logger is password protected and Allow RD is disabled.
16. Graph

- Graph tab will auto open after a download or a previously saved file is open
- X-axis is always date & time axis
- Y-axis is Temperature or Temperature/Humidity (depending on the data logger type)
- If the logger is with one sensor, graph will display different colors in background at respective alarm range
- If the logger is multi-sensor, by default background is light blue (as above), settings can always be changed at any time
- Options → View Tab
  - Graph Legend area has all the sensors available with respective information (S.No. & sensor)
  - User can click each or any of these bullets to select / deselect that particular sensor in the graph.
  - Graph will change accordingly in real time
• If only one sensor at a given time is selected, the background will display colors based on alarm conditions (HH, H, L, LL)

Mouse Zoom:
User can select some area in graph and it will zoom to the range for closer look

Mouse Tool Tip:
Hovering the mouse over the graph will show the reading no., time and data information in entire graph

17. Save/ save as

If AUTO SAVE is checked in options, the data file will be saved automatically in default folder or user can manually save the data from the icon or from MENU → File → Save/save as

Save: by default extension *.CVT in default folder
Save as: user can choose extension from drop down list *.CVT, *.TXT, *.CSV
Or as PDF file, by default (PDF icon ) saves in default directory
Above options can be selected to ‘auto save’ different file types, this feature helps users to not to lose the data.

18. Auto-open PDF

ConsolePlus generates PDF automatically if selected in options → ‘auto save PDF’.
If the next option → ‘auto open PDF’ is enabled, generated PDF will open automatically as soon as the logger is connected and data is downloaded.

Adobe PDF applications must be installed on the computer. If Adobe PDF is not installed, user may receive a message during installation of ConsolePlus. If not installed, option → ‘auto open PDF’ will be permanently greyed out / disabled. Until the Adobe PDF is installed

19. Histogram

Analytical view of the data is displayed
## 20. Table

All the data from the logger (from START to FINISH of the current/last trip) can be viewed here. Scroll down to view all the data of the logger. Readings are in colored fonts according to alarm settings triggered to make them easier to understand and detect.

<table>
<thead>
<tr>
<th>#</th>
<th>Elapsed</th>
<th>Time</th>
<th>intT°C</th>
<th>intH%</th>
<th>extT°C</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>00:01:50</td>
<td>02/05/2013 17:48:04</td>
<td>12.9</td>
<td>21.1</td>
<td>-18.9</td>
</tr>
<tr>
<td>13</td>
<td>00:02:00</td>
<td>02/05/2013 17:48:14</td>
<td>12.2</td>
<td>21.9</td>
<td>-19.7</td>
</tr>
<tr>
<td>14</td>
<td>00:02:10</td>
<td>02/05/2013 17:48:24</td>
<td>11.4</td>
<td>21.1</td>
<td>-20.4</td>
</tr>
<tr>
<td>15</td>
<td>00:02:20</td>
<td>02/05/2013 17:48:34</td>
<td>10.7</td>
<td>21.3</td>
<td>-21.0</td>
</tr>
<tr>
<td>16</td>
<td>00:02:30</td>
<td>02/05/2013 17:48:44</td>
<td>10.1</td>
<td>22.0</td>
<td>-21.4</td>
</tr>
<tr>
<td>17</td>
<td>00:02:40</td>
<td>02/05/2013 17:49:54</td>
<td>9.4</td>
<td>21.9</td>
<td>-21.6</td>
</tr>
<tr>
<td>18</td>
<td>00:03:00</td>
<td>02/05/2013 17:49:14</td>
<td>8.8</td>
<td>22.0</td>
<td>-22.1</td>
</tr>
<tr>
<td>19</td>
<td>00:03:10</td>
<td>02/05/2013 17:49:24</td>
<td>8.1</td>
<td>22.0</td>
<td>-22.4</td>
</tr>
<tr>
<td>20</td>
<td>00:03:20</td>
<td>02/05/2013 17:49:34</td>
<td>8.2</td>
<td>35.2</td>
<td>-0.1</td>
</tr>
<tr>
<td>21</td>
<td>00:03:30</td>
<td>02/05/2013 17:49:44</td>
<td>9.2</td>
<td>67.0</td>
<td>10.2</td>
</tr>
<tr>
<td>22</td>
<td>00:03:40</td>
<td>02/05/2013 17:49:54</td>
<td>10.0</td>
<td>76.6</td>
<td>65.7</td>
</tr>
</tbody>
</table>

| 23 | 00:03:40   | 02/05/2013 17:49:54 | 66.7   | 9.2   | -40.7  |
| 24 | 00:04:00   | 02/05/2013 17:50:04 | 74.3   | 8.8   | 23.8   |
| 25 | 00:04:00   | 02/05/2013 17:50:14 | 33.2   | 26.4  | 20.3   |
| 26 | 00:04:10   | 02/05/2013 17:50:24 | 24.2   | 39.3  | 19.5   |
| 27 | 00:04:20   | 02/05/2013 17:50:34 | 20.6   | 47.1  | 16.5   |
| 28 | 00:04:30   | 02/05/2013 17:50:44 | 18.7   | 52.8  | 10.5   |
| 29 | 00:04:40   | 02/05/2013 17:50:54 | 17.6   | 56.6  | 6.6    |
| 30 | 00:05:00   | 02/05/2013 17:51:04 | 16.9   | 58.8  | 4.8    |
| 31 | 00:05:00   | 02/05/2013 17:51:14 | 16.5   | 60.1  | 20.5   |
| 32 | 00:05:10   | 02/05/2013 17:51:24 | 16.2   | 64.6  | 21.4   |
| 33 | 00:05:20   | 02/05/2013 17:51:34 | 16.3   | 69.2  | 21.3   |
| 34 | 00:05:30   | 02/05/2013 17:51:44 | 16.5   | 68.0  | 21.3   |
| 35 | 00:05:40   | 02/05/2013 17:51:54 | 16.8   | 71.3  | 21.3   |
| 36 | 00:06:00   | 02/05/2013 17:52:04 | 17.0   | 65.6  | 21.3   |
| 37 | 00:06:10   | 02/05/2013 17:52:14 | 17.7   | 63.1  | 22.0   |
| 38 | 00:06:20   | 02/05/2013 17:52:24 | 17.4   | 61.7  | 22.1   |
| 39 | 00:06:30   | 02/05/2013 17:52:34 | 17.5   | 60.7  | 22.2   |
| 40 | 00:06:40   | 02/05/2013 17:52:44 | 17.0   | 59.7  | 22.2   |
| 41 | 00:07:00   | 02/05/2013 17:53:04 | 21.9   | 98.2  | 24.0   |
| 42 | 00:07:10   | 02/05/2013 17:53:14 | 21.3   | 98.5  | 24.0   |
| 43 | 00:07:20   | 02/05/2013 17:53:24 | 20.9   | 98.8  | 24.0   |
| 44 | 00:07:30   | 02/05/2013 17:53:34 | 20.6   | 99.1  | 24.0   |
| 45 | 00:07:40   | 02/05/2013 17:53:44 | 20.3   | 99.2  | 23.9   |
| 46 | 00:07:50   | 02/05/2013 17:53:54 | 20.1   | 99.0  | 23.8   |

### Color Coding:
- **Below LOW LOW alarm**: Dark Blue color
- **Above HIGH HIGH alarm**: Dark Red color
- **Below LOW alarm**: Light Blue color
- **Below HIGH alarm**: Light Red color
- **Readings within specification**: Green color
21. Summary

Detailed summary of the trip and basic information of the logger and all sensors can be viewed here.
22. Bookmark

A Bookmark displays a MARKED reading, users can mark a reading during the logging by briefly holding START button on the logger for 3-5 seconds, MARKED text displayed on the LCD display of the logger screen for few seconds, and that reading is marked with time stamp

Once data is downloaded

**Graph view**, a STAR is placed at the time and reading

**Table view**, bookmarked readings are highlighted with grey background
23. MKT

User can view Mean Kinetic Temperature; on summary tab. **Mean kinetic temperature (MKT)** is a simplified way of expressing the overall effect of temperature fluctuations during storage or transit of perishable goods.

Activation energy (typically within 60–100 kJ·mol\(^{-1}\) for solids or liquids), ConsolePlus allow users to customize activation energy. This option is available in Options / settings on general tab.

24. Multilink

User is allowed to link multiple files (with extension CVT) by selecting with mouse or by pressing shift and selecting individual files. Compare the results with different options.

I. Compare trip data based on actual date/time of each reading
II. Compare trip data from different date/time period(s)

The linked files also can be saved into TXT and CSV format for further evaluation or to print. Data from multiple files also reflects in Graph, Histogram, Table and Summary

I. Compare trip data based on actual date/time of each reading
II. Compare trip data from different date/time period(s)
25. Battery Status

Logger’s battery status is directly displayed on program tab. Software can detect the status and report with icon

- OK battery
- Low battery

If the data logger has low battery, low battery symbol is displayed on LCD of the data logger (if logger supports LCD)

26. Print / Print-preview

Print / Print-preview functions are available in ConsolePlus, when a file is open or logger is connected and downloaded. Available in main menu and icons are at the top of the application

27. Update

**ConsolePlus** software will check for updates automatically and will display a confirmation message when application is launched.

Also it can be easily updated manually from MENU tab, by selecting ‘check for update’. So user need not to download a separate file all the time.

For more information about product and applications please contact techsupport@escortdataloggers.com